
MOS WORD 2016 

OBJECTIVE 1: Create and Manage Documents 

Part 1.1. Create documents 

• Create a blank document 

• Create a blank document using a template 

• Open a PDF in Word for editing 

• Insert text from a file or external source 

 TASK 

1 Start Word, and do the following: 

a. Create a new document based on the built-in Blank document 

template.  

b. Save the document in the practice file folder as  

MyBlankDoc.docx. 

2 In the open document, 

a. Create a document based on the Fax (Equity theme) template. 

b. Save the document in the practice file folder as MyFaxCover.docx. 

3 Open the Word_1-1b text file in Word, and do following: 

a.   Select the text file title, Nursery Rhymes, and format it as bold. 

b. Save a copy of the file in the practice file folder as 

MyNurseryRhymes.docx to preserve the formatting 

4 Open PDF Word_1-1c.pdf, do the following: 

a.   Modify the PDF file in Word by deleting the Technical Review paragraph 

from the last page of the file.  
 b.   Save the modified file in the practice file folder as a document named 

MyPDF.docx. 

5 In the end of MyNurseryRhymes.docx, insert text from file Word 1-

1b.txt 

 

Part 1. 2. Navigate Through a Document 

• Search for text    

• Insert hyperlinks    

• Create bookmarks 

• Move to a specific location or object in a document 

 TASK 

6 Open the Word_1-2 document, and then do the following: 

a.   Search all instances of toy.   Move between the search results by 

using the navigation buttons on the Results page 

 b.   Modify the search options to locate only instances of the capitalized word 

Toymakers, and then review the results. 

c. Perform an advanced search for all instances of Toy or toy, either capitalized 

or lowercase, that have the Heading 2 style applied. 

 

7 Display the table of contents, and then do the following: 

a.   Insert a hyperlink from each of the six first-level headings in the table of 



contents to the corresponding heading in the document.  
 b. Move to the Resources section of the document, and do the following:In 

the first paragraph, insert a hyperlink from the URL wingtiptoys.com to the 

website at http://www.wingtiptoys.com. Change the display text of the 

hyperlink from wingtiptoys.com to the Wingtip Toys website and set the target 

frame to display the website in a new window. 

8 In the Contact Us section of the page, do the following: 

a. Insert a hyperlink from sarah@wingtiptoys.com that will create an email 

message addressed sarah@wingtiptoys.com, with the subject MOS Study 

Guide message. Ensure that the display text remains arah@wingtiptoys.com.  
 b.  Select the name Lola Jacobsen and insert a bookmark named 

SalesManager.  
 c Attach a bookmark named DesignManager to the name Sarah Jones. 

9 Return to the beginning of the document, and then use the Go To function to 

do the following: 

a.   Move between graphics in the document until you reach the end.  
 b.   Move from the last graphic to the top of page 3.  
 c.  Move from the top of page 3 to the SalesManager bookmark. 

 

 

Part 1.3. Format document 

• Modify page setup 

• Apply document themes 

• Apply document style sets 

• Insert headers and footers 

• Insert page numbers 

• Format page background elements 

 TASK 

10 Open the Word_1-3 document, and then do the following: 

a.   Turn on automatic hyphenation.  
 b. Apply the Facet theme to the document.  
 c. Change the color set to the Red Orange palette, and change the font set to 

Corbel. 

11 a. On page 2, add a Facet (Even Page) header and the Circle, Right page 

number in the right margin. Configure the header elements so they do not 

appear on the first page of the document.  
 b. Add a diagonal watermark that displays the text Example Only to the page 

background. Format the text of the watermark as semitransparent 54-point 

orange (Accent 4) text. Apply the watermark and verify that it appears on all 

pages of the document.  
c. Apply the Casual style set to the document. 

 



 

Part 1. 4. Customize document options and views 

• Change document views 

• Customize views by using zoom settings 

• Customize the Quick Access toolbar 

• Split the window 

• Add document properties 

• Show or hide formatting symbols 

 TASK 

12 Open the Word_1-4 document, and do the following: 

a.   Display the document content in Read Mode view.  
 b.  Display two windows of the document, then side by side in Print Layout 

view.  
 c. Split the window, and display the document view in the upper split pane at 

235% and the document view in the lower split pane at 45%.  
 d. Close the lower split pane, and display the document at page width. 

13 Display the Quick Access Toolbar page of the Word Options dialog box, and 

do the following: 

a.   Create a Quick Access Toolbar that appears only in this document.  
 b.  Add the Format Painter button, the Shading button, and the More 

Shading Colors button from the Home tab to the document-specific Quick 

Access Toolbar.  
 c.  Add the Insert Comment button and the Accept All changes from the 

Review tab to the document-specific Quick Access Toolbar.  
 d.  Insert a separator between the three commands from the Home tab and the 

two commands from the Review tab. 

14 Display the Customize Ribbon page of the Word Options dialog box, and do 

the following: 

a.   Display the Developer tab on the ribbon.  
 b.  Hide the Mailings tab.  
 c.  Create a custom tab named Favorites with a custom group named 

Colors. Assign a symbol of your choice to the group.  
 d. Move the Proofing group of commands from the Review tab to your 

Favorites tab.  
 e. Add the Font Color and Text Highlight Color buttons to the Colors group 

15 Close the Word Options dialog box, display the document properties, and do 

the following: 

a.   Set the Title property to Simple Room Design and the Subject property to 

Room Planner.  
 b.   Assign the keywords (tags) redecorating, color, and style to the 

document.  
 c.   Add yourself as the only author.  
 d.   Add a custom property named Document Number with a value of 1001.  

16 a. Check spelling the document and show all the formatting marks.  

b. Save the Word 1-4 document. 

 

Part 1.5.   Print and save documents 



• Modify print settings 

• Save documents in alternative file formats 

• Print all or part of a document 

• Inspect a document for hidden properties or personal information 

• Inspect a document for accessibility issues 

• Inspect a document for compatibility issues 

 TASK 

17 Open the Word_1-5 document, review its content, and then do the 

following: 

a. Print only Section 1 of the document, with the scaling set to  

2 Pages Per Sheet.  

 b.  Save a copy of the document in the practice file folder as a PDF file 

named MyBookmarks that is optimized for online publishing and 

includes bookmarks to all the document headings.  

 c.  Save a copy of the document in the practice file folder as a file named 

MyCompatible that is compatible with Word 2003. 

18 From File Explorer, do the following: 

a. Open the MyBookmarks file in a PDF reading program (such as 

Microsoft Reader), display the bookmarks, and verify that clicking 

bookmarks moves to the corresponding headings.  

 b.  Open the MyCompatible document in Word 2016, ensure that 

Compatibility Mode appears in the title bar, and review the document to 

identify any changes resulting from the file compatibility downgrade. 

19 Check hidden properties or personal information and remove these 

properties 

 

OBJECTIVE 2: Format text, paragraphs, and sections 

Part 2.1. Insert text and paragraphs 

• Find and replace text 

• Cut, copy and paste text 

• Replace text by using AutoCorrect 

• Insert special characters 

 TASK 

21 Open the Word_2-1a document and do the following: 

a. In the first paragraph, insert the registered trademark symbol (™) after 

the word Microsoft.  

 b.  Replace all instances of (trademark) in the document with paragraph 

character (¶) with font size 30 and red font color. Ensure that you replace 

only instances in which the word trademark is in parentheses, and no 

other version of the word.  

22 Open the Word_2-1b presentation in PowerPoint and do the following: 

a. In the left pane, click the Slide 4 thumbnail. Use any technique to copy 

Slide 4 to the Clipboard.  

 b.  Return to the Word_2-1a document and do the following:Display the 

Clipboard pane and verify that the copied slide is the most recent item on 



the Clipboard.  

 c.  In the second paragraph, replace the text <link to slide here> with a 

linked copy of Slide 4, as a PowerPoint Slide Object.  Save the 

document, but don’t close it. 

d.  In the Word_2-1b presentation, with Slide 4 active, click the slide 

header and change an expert to a superstar. Save and close the Word 2-

1b presentation. 

e.  Return to the Word_2-1a document and do the following: Update the 

link to the slide, and verify that the document displays the most recent 

slide content. 

f. Move to the end of the document, and append the contents of the  

Word_2-1c document. Review the complete document content. 

 

Part 2.2.  Format text and paragraphs 

• Format text and Paragraphs 

• Apply font formatting 

• Apply formatting by using Format Painter 

• Set line and paragraph spacing and indentation 

• Clear formatting 

• Apply a text highlight color to text selections 

• Apply built-in styles to text 

• Change text to WordArt 

 TASK 

23 Open the Word_2-2 document, display the Navigation pane and the Styles 

pane, and do the following: 

a. From the Styles pane, select all paragraphs that are formatted as Heading 3.   
Apply the Heading 2 style to the selected paragraphs.  
 b.  Apply the Heading 1 style to the Financial Summary heading.  
 c.   Use the Format Painter to copy the style from the Financial Summary 

heading to the Financial Statements and Statement Notes headings. 

24 Move to the beginning of the document, and do the following: 

a.   Set the paragraph spacing for the entire document to Relaxed.  
 b.   Immediately after the document title, select the text A Brief Review of 

Our Finances and format it as a WordArt object, using a built-in style of your 

choice. 

25 With the WordArt object selected, do the following.  

a. Set the Text Fill color to Brown, Text 2.  
 b.   Set the Text Outline color to Orange, Accent 1.  
 c.  Set the Reflection effect to Tight Reflection: Touching.  
 d.  Remove any Shadow, Glow, Bevel, or 3-D Rotation effects.  
 e.  Apply the Triangle: Down transform (in the Warp category).  
 f.  Set the width of the WordArt object to 4”.  
 g.  Set the text wrapping to Top and Bottom, and then center the WordArt 

object on the page, between the title and the Financial Summary heading. 

 

Part 2.3. Order and group text and paragraphs 



• Format text in multiple columns 

• Insert page, section, or column breaks. 

• Change page setup options for a section. 

 TASK 

26 Open the Word_2-3 document, and do the following: 

a.   On the first page, insert a page break before the Process heading.  
 b.   In the Pre-Plan Project section, select the heading, the paragraph, and the 

list items. Format each of the selected paragraphs to stay on the same page as 

the paragraph that follows it, and to keep all the lines of the paragraph 

together.  
 c.   Select the Questions for Team Leaders and Questions for Department 

Reps headings and the lists that follow them. Format the selection in two 

columns of equal width. Set the space between the columns to 0.3" and place 

a vertical line between the columns.  
 d.  Insert a column break before the Questions for Department Reps heading 

so that each list is in its own column. 

e. Near the end of the document, locate the Carry out project section. Create a 

separate document section that contains only the content of the Carry out 

project section, on its own page. For only this section, set the orientation to 

Landscape and all four margins to 2”.  
 f.   Preview the document on the Print page of the Backstage view to verify the 

changes. 

 

OBJECTIVE 3: Create tables and lists 

Part 3.1. Create tables 

• Convert text to tables 

• Convert tables to text 

• Create a table by specifying rows and columns 

• Apply table styles 

 TASK 

27 Open the Word_3-1 document, and do the following: 

a. In the Consultation Request section, convert the paragraphs that follow the 

heading into a page-width table with five equal-width columns.  
 b.  In the Mileage section, convert the tabbed list into a table that has two 

columns and six rows. Ensure that each column exactly fits its contents.  
 c.  Apply the Grid Table 4 – Accent 1 built-in table style to the table. 

Configure the table style options to emphasize the header row and to have 

banded columns.   (Clear all other check boxes.)  
 d.  In the Consultation section, convert the table to a tabbed list.  
 e.   In the blank paragraph below the Estimate heading, insert an empty table 

that is three columns wide and four rows high, with each column exactly 1.5” 

wide. Apply the List Table 5 Dark – Accent 1 built-in table style to the table, 

with the default table style options. 

f. Before Estimate heading, insert file Word_3-1b.xlsx 

  

Part 3.2. Modify tables 



• Sort table data 

• Configure cell margins and spacing 

• Merge and split cells 

• Resize tables, rows, and columns 

• Split tables 

• Configure a repeating row header 

 TASK 

28 Open the Word_3-2 document, and do the following: 

a.   In the Customer List section, delete the ID column from the table.  
 b.   Perform a nested sort to sort the table in ascending order by State, then by 

City, and then by Last Name.  
 c.  Delete all rows that contain contacts located in Boston, MA.  
 d.  Add two blank columns to the right side of the table. In the header row, 

enter Date at the top of the first column and Time at the top of the second 

column.  
 e.   Add a blank row to the top of the table. In the table style options, turn off 

the Header Row formatting.  
 f.   In the blank row, merge the cells above the Last Name, First Name, 

Address, City, and State columns into one cell. Enter Customer in the merged 

cell.  
 g.  In the same row, merge the cells above the Date and Time columns. Enter 

Appointment in the merged cell.  
 h.  Select the top two rows of the table. Format the text as bold, and center 

the text horizontally and vertically within the cells.  
 i.  Change the width of the table to 100 Percent of the page width.  
 j.  Select the table rows that contain customer information. Set the height of 

the rows to 0.4” and the cell alignment to Align Center Left.  
 k.  Scroll to page 2 of the document, which now contains several rows of the 

table. Configure the table to repeat the Customer/Appointment 

header row at the top of the second page. 

 

Part 3.3. Create and Modify lists 

• Create a numbered or bulleted list 

• Change bullet characters or number formats for a list level 

• Define a custom bullet character or number format 

• Increase or decrease list levels 

• Restart or continue list numbering 

• Set starting number value 

 TASK 

29 In the Word 3-3 document, do the following: 

a.   In the Characters of a Hit Fantasy section, format the four paragraphs as a 

bulleted list that uses the standard bullet character (). • 

 b.   In the sections titled The Hero and The Teacher, format the paragraphs as 

bulleted lists that uses a custom bullet symbol of your choice from the 

Wingdings font.  
 c.   In the Plot Elements of a Hit Fantasy section, format the three paragraphs 



as a bulleted list that uses the four-diamond character ().❖ 

 

30  In the section titled The Sequence of Events, do the following: 

a.   Format the four paragraphs below the heading as a numbered list that  uses 

the A. B. C.   number format.  
 b.   Paste a copy of the list into the last blank paragraph of the document, and 

restart the list numbering. Change the number format of the second list to the 

1) 2) 3) format.  
 c.  Immediately below the second list, paste another copy of the list, and 

change it to a second-level list.  
 d.  Change the second-level list to a bulleted list that uses the square bullet 

character ().◼ 

 

OBJECTIVE 4: Create and manage references 

Part 4.1. Create and manage reference markers 

• Insert footnotes and endnotes 

• Modify footnotes and endnotes properties 

• Create bibliography citation sources 

• Insert bibliography citation sources 

• Insert figure and table captions 

• Modify caption properties 

 TASK 

31 Open the Word_4-1 document. In the About the Brothers Grimm section, do 

the following: 

a.   Immediately after the name Jacob, insert an endnote that says Jacob 

Grimm lived from 1785-1863.  
 b.  Immediately after the name Wilhelm, insert an endnote that says Wilhelm 

Grimm lived from 1786-1859.  
 c.   After the name Hanau, insert a footnote that says Hanau is located near 

Frankfurt, in the German state of Hesse.  
 d.   Modify the footnote location so that it appears immediately below the text 

on page 1. 

e. Convert the two endnotes to footnotes, either individually or at the same 

time.  
 f.  Change the footnote numbering format to the range of symbols.  
 g.  Reposition the footnotes at the bottom of the page. 

32  Return to the beginning of the document and do the following: 

a. Position the cursor at the end of the first paragraph after the About the 

Brothers Grimm heading. Create a bibliography source placeholder with the 

name GrimmData.  
 b. Edit the placeholder to create a bibliography source that cites the online 

article at https://en.wikipedia.org/wiki/Brothers_Grimm.   Use the 

Document from Web Site source type. Leave the author blank but complete the 

remaining required fields, using the current date.  
 c.   Display the Source Manager and verify that the Current List contains 

the source you created. 

33  Locate the first graphic, and do the following: 

a.   Caption the graphic as Figure 1. Man sleeping under apple tree, with the 



caption below the graphic.  
 b.   If text from the next paragraph comes between the graphic and the caption, 

select the caption container and move it upward so that it clears the text. 

 

34 Locate the second graphic, and do the following: 

a. Caption the graphic as Figure 2. The fox, with the caption located above the 

graphic.  
 b.  Resize the caption container to remove the extra white space that blocks the 

graphic. 

 

35 Locate the third graphic, and do the following: 

a. Caption the graphic as Figure 3. Golden bird in a cage, with the caption 

above the graphic.  
 b.   Widen the caption container to fit the entire caption on one line.  
 c.   Resize the caption container to remove the extra white space that blocks 

the graphic. 

 

 

Part 4.2. Create and manage simple reference  

• Insert a standard table of contents 

• Update a table of contents 

• Insert a cover page 

 TASK 

36 Open the Word_4-2a document, and do the following: 

a. In the blank paragraph after the title (Office Procedures), insert a table of 

contents that uses the built-in Automatic Table 1 style. Take the necessary 

steps to ensure that the page numbers in the table of contents are correct after 

the TOC is inserted.  
 b.   In the table of contents, note the page number of the last heading (Shipping 

Quick Reference). Ctrl+click the heading to move to that location in the 

document. Verify that the page number of the heading matches the page 

number in the table of contents.  
 c.   Insert a Facet cover page.   On the cover page, replace the Document Title 

property placeholder with Office Procedures.   Then delete the title from the 

table of contents page.  

37 Open the Word_4-2b document, and perform the following tasks to change the 

document page count and heading locations: 

a.   Remove the cover page.  
 b.  Change the page size of the whole document to 5.5” x 8.5”, which might be 

named Statement or Half Letter depending on your printer. If this page size 

doesn’t appear in your Size list, you can create it as a custom page size. 

 

38 Return to the beginning of the document, and do the following: 

a. Update the table of contents.  

b. Verify that the page number of the last heading in the table of contents 

matches the page number of the heading. 

 

OBJECTIVE 5: Insert and format graphic elements 



Part 5.1. Insert graphic elements. 

• Insert shapes 

• Insert pictures 

• Insert a screen shot or screen clipping 

• Insert text boxes 

 TASK 

39 Open the Word_5-1a document, and do the following: 

Position the cursor in the blank, centered paragraph after the first paragraph of 

text. Insert the Word_5-1b picture from the practice file folder. 

40 Position the cursor at the beginning of the fourth paragraph of text (after the 

first quote), and do the following: 

a. Insert an Ion Quote (Dark) text box in its default location. 

b. From the beginning of the eighth paragraph of the document text, copy the 

sentence “And when the princess opened the door the frog came in, and 

slept upon her pillow as before, till the morning broke.” 

c. In the text box, select the quote placeholder and replace it with the copied 

sentence, merging the formatting. Then delete the [Cite your source here] 

placeholder. 

 

41 Move to the end of the document and do the following: 

a. Insert a Scroll: Horizontal shape (from the Stars and Banners category) of 

the default size. 

b. In the shape, insert the text The End! 

 

 

Part 5.2. Format graphic elements. 

• Format Graphic Elements 

• Apply artistic effects 

• Apply picture effects 

• Remove picture backgrounds 

• Formats objects 

• Apply a picture style 

• Wrap text around objects 

• Position objects 

• Add alternative text to objects for accessibility 

 TASK 

42 Open the Word_5-2 document. On the first page, do the following: 

a. Apply the Metal Oval picture style to the picture. 

b. Resize the picture so that it is 2.5” wide and maintain the original aspect 

ratio. 

c. Position the picture in the center of the page (using the Middle Center 

position), and set the text wrapping to Tight. 

d. Delete the empty paragraph mark near the top of the picture. 

e. Set the picture’s alt text title to The Princess and the alt text description to 

Photo of a young girl in a fancy blue dress. 

 



43 On the second page, set the position of the text box to Top Right with Square 

Text Wrapping. 

44 Move to the end of the document, and do the following: 

a. Set the height of the scroll shape to 1” and the width to 3”. 

b. Drag the shape to the horizontal center of the page, just after the end of the 

story. 

c. Apply the Moderate Effect – Teal, Accent 5 style to the shape. 

d. Set the font size of the shape text to 24 points. 

 

Part 5.3. Format graphic elements. 

• Create a SmartArt graphic 

• Format a SmartArt graphic 

• Modify SmartArt graphic content 

 TASK 

45 Open the Word_5-3 document, and do the following: 

a. In the blank paragraph that follows the list, create a SmartArt graphic based 

on the Basic Timeline layout. 

b. Copy or enter the list items into the Text pane of the SmartArt graphic. 

Remove any unused bullet points. 

c. In the Text pane, at the beginning of the list, add a first-level entry for 

Princess loses ball in pond. 

d. In the SmartArt graphic, to the right of the last shape, add a shape labeled 

The End!. 

e. Demote “Promises to love frog” and “Breaks promise” to second-level 

items. 

f. Change the layout of the SmartArt graphic to Basic Bending Process. 

g. Change the color scheme of the SmartArt graphic to Colorful Range –

Accent Colors 5 to 6. 

h. Apply the Moderate Effect style to the SmartArt graphic. 

 

THE END! 


